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Challenge Images: Beach Huts & Rome Stairway

In this lesson, we’re going to work on some challenge images that were sent by 
Masters Academy members. One of the images contains colorful beach huts along 
with some distracting elements. We will use some retouching techniques to re-
move the distractions and optimize the image. The other image features a spiral 
staircase, looking straight up into a large window. With this photo, we’re going to 
use some techniques for evening out the color of light, as well as some techniques 
for retouching the brownish areas in the window. 

Beach huts image

Missing Profile warning From Adobe Bridge, we’ll double-click on the beach huts 
photo to open it in Photoshop. With this particular image, a “Missing Profile” warn-
ing pops up on our screen, asking us what we’d like to do. You sometimes end 
up with a missing profile if you are saving out the image for use on the Internet. 
I would like to choose one of the more commonly-used profiles from the Assign 
Profile menu, BUT there is no way to preview what these profiles would look like 
before opening the image. Because of this, I like to choose the “Leave as is” option 
and then click OK. We will assign the profile in the next step. 

In the challenge image on the left, we will use some retouching techniques to remove the 
trash bin between the huts and the seaweed pile in the sand. In the image on the right, we 
will learn some techniques for evening out the color of light and retouching the brown pan-
els in the window.
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With the image open in Photoshop, 
we’ll go to the Edit menu and choose 
Assign Profile. (The only time I’ll use 
“Assign Profile” is when the profile is 
missing or incorrect.) Within the As-
sign Profile dialog box, we’ll choose 
the Profile option at the bottom and 
make sure that the Preview check 
box is turned on so that we can see 
how the image looks with the var-
ious profiles. We’ll use the Profile 

menu to switch between the different profiles, choosing the one that makes the 
image look most desirable. In the video example image, that is the sRGB profile. 
Then, we’ll click OK. 

If the image you’re trying to open has ho profile 
assigned, this warning will appear. 

Here, we accessed the Assign Profile dialog via the Edit menu. We chose the Profile option 
and can now use the menu to assign a profile, previewing each menu option in the main  
image window.
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Trash bin retouch  The first retouching job we’re going to tackle is the green trash 
bin. The challenge is that it’s located behind a wire mesh fence. In order to remove 
the trash bin while keeping the fence intact, we’re going to copy parts of the fence 
from the clean area to the left of the bin and then paste that content over the area 
with the bin. 

We’ll activate the Clone Stamp Tool, which is designed to create an exact copy 
from the source area to paste onto the target area. The cursor will turn into a 
round tool tip that we can resize by using the left and right bracket keys ( [ ] ). 
To use the Clone Stamp Tool, we will hold down the Option key (Alt on Win) and 
click on the source area (the area we want to copy). Then we’ll release the Option 
key and position the round cursor over the area we want to retouch. A preview of 
what we’re pasting will appear inside the round cursor and it can be a good idea 
to make the cursor large so that we can more easily line up the content. With the 
cursor large, we will click once to establish alignment. Then, we can immediately 
use the undo command (Command+Z; Ctrl+Z) because the cursor was TOO large. 
We only did this so that the tool tip knows the correct alignment and positioning. 
We can then make the tool tip much smaller again so that we can paint with more 
precision. We’ll click and drag in order to “paint” the source content over the re-
touch area. 

It’s always a good idea to apply retouch work on a new, empty layer. Click on the 
New Layer icon at the bottom of the Layers panel to add an empty layer just above 
the image layer. When using the Clone Stamp Tool on an empty layer, we need 

to make sure that Sample 
menu is set to Current & 
Below. The Sample menu 
can be found in the Op-
tions Bar that runs above 
the main image window. 

When  using the Clone Stamp Tool on an empty layer, The 
Sample menu must be set to Current & Below or All Layers.
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Looking at the wire fence, 
there are two vertical dividers, 
one of which is right next to 
the trash bin. We’ll sample an 
area on the farther vertical di-
vider and then match up that 
sampled area to the divider 
closer to the bin. We’ll make 
the cursor large and click to 
establish alignment. Then we’ll 
undo, make the brush smaller 
again and we’ll click and drag 
to replace the contents with 
the area we sampled. 

Sometimes, when trying to line up objects (like the vertical fence divider), you’ll 
accidentally click in the wrong place, or the retouch job will be off by a few pixels. 
If that’s the case, first use the Undo command (Command+Z; Ctrl+Z). The tool will 
have locked in the positioning, but you can adjust it by using a keyboard short-
cut. Hold down the Shift and Option keys (Shift and Alt on Win) and then use the 
arrow keys on your keyboard to nudge the retouch work left, right, up or down.  
Then go ahead to click and drag on the image, pasting the source content onto 
the retouch area. We’ll paint in the clean fence area, moving to the right until the 
big vertical pole starts to show up. If we accidentally paint some of the pole into 
our retouch area, it’s no big deal, because we’re retouching on a separate layer. We 
could simply activate the Eraser Tool and erase the unwanted pole. 

We will then use the Clone Stamp Tool to sample another clean area of fence to 
the left of the trash bin. We’ll sample an area from the top of the fence so that 
we can use it to line up with the top of the fence where the trash bin is. We’ll line 
up the cursor so the horizontal lines match and then start painting, covering as 

The Clone Stamp Tool is used to copy fence area from 
the left and paste it over the trash bin on the right.
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much fence area as we can before we start adding unwanted content. To finish 
removing the trash bin, we’ll continue this process, sampling areas of clean fence 
and then painting over the bin, taking care to make sure that the grid lines of the 
fence match perfectly.

Seaweed removal Next, we’re go-
ing to remove the distracting pile 
of seaweed that’s sitting below the 
beach huts. When it comes to re-
moving objects like this, I will try 
to isolate the object so that it’s 
completely surrounded by content 
that is all the same. In this example, 
we’ll isolate parts of the seaweed 
so that it is completely surrounded 
by sand and is no longer attached 
to the vertical poles under the hut. 

There appears to be a line where the sand changes color a little, so we’ll use that 
line to clone across horizontally. Working on the top, retouching layer, we’ll activate 
the Clone Stamp Tool and Option+click (Alt+click on Win) on the line in the sand 
to the left of the seaweed pile in order to copy. Then, we’ll hover the round cursor 
over the seaweed, making the cursor bigger as needed to line up the content just 

We will break up this pile of seaweed into smaller 
chunks so that it can more easily be removed.

The Clone Stamp 
Tool is being used 
to copy sand area 
on the left and line 
it up over the sea-
weed area on the 
right. We’re tem-
porarily using a 
large brush in order 
to better see how 
things are lining up.
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right. We’ll click the mouse but-
ton to establish where the clon-
ing should apply and then im-
mediately Undo (Command+Z; 
Ctrl+Z). Then, we’ll switch to a 
smaller brush so that we have 
more precision for doing the 
actual cloning. We’ll click and 
drag to apply the Clone Stamp 
Tool, creating a gap between 
the pole and the rest of the sea-
weed. We’ll then do the same 
thing in between the two poles and then again on the right pole. We’re basically 
isolating the seaweed into smaller chunks so we can more easily remove them. 

Next, we’re going to use the Spot Healing Brush in order to remove the isolated 
chunks of seaweed. After activating the Spot Healing Brush, we’ll need to make 
sure that the “Sample All Layers” check box is turned on (It’s located in the Op-
tions Bar above the main image window.). This will allow the tool to use the con-
tent from the underlying image layer in order to fill in the area we specify. If this 
setting were kept off, it would only be able to sample from the active retouching 
layer, which is mostly empty. 

The Clone Stamp Tool was used to separate the sea-
weed pile into chunks. The isolated chunk on the left 
will then be removed with the Spot Healing Brush.

When using the Spot Healing Brush on an empty layer, or a layer that is separate from the 
image layer, you’ll need to make sure that the Sample All Layers check box is turned on.
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We’ll use the Spot Healing Brush to paint over one of the isolated chunks of sea-
weed, making sure that it’s completely covered before releasing the mouse but-
ton. We’ll do the same thing with the seaweed on the right. 

Now, the only seaweed remaining is 
what’s right in front of the two poles. 
We’ll again activate the Clone Stamp Tool 
and use it to sample from a clean area on 
the edge of a pole. We’ll line up that sam-
pled edge on the lower part of the pole 
(where the seaweed is) and paint, replac-
ing the seaweed with the source area we 
copied from. The same thing will be done 
on the other pole.

Now that the unwanted object is removed, 
we need to clean things up. After using 
the Clone Stamp Tool a good amount, it’s 
common to have repeating shapes that 
can make it appear obvious that we did 
retouch work. We’ll use the Spot Heal-
ing Brush to make sure that any repeated 
shapes and/or textures are broken up.

The Spot Healing Brush is used to remove the isolated chunks of seaweed. Afterwards, we 
are only left with the seaweed that is in front of the two poles.

The Clone Stamp Tool is used to remove 
the seaweed from in front of the poles.

The Spot Heal-
ing Brush is 
being used to 
break up any 
repeating ele-
ments caused 
by the Clone 
Stamp Tool.
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There was a darker line in the sand that ran below the beach huts and this line got 
removed when we did the retouch work. If we wanted to replace it, we could copy 
content from the area beneath the hut on the right and use it to fill in the area be-
neath the hut on the left. The only risk here is that it could look obvious that there 
is a repeating element. To make it less obvious, we’ll use some settings located 
in the Clone Source panel. These settings will allow us to scale, rotate or flip the 
copied content as we paste it to a new location. If the Clone Source panel is not al-
ready visible in your interface, go to the Window menu and choose Clone Source. 

We’ll activate the Healing Brush for this 
job because it will try to match the re-
touch area to the surrounding area. We’ll 
make sure that the Sample menu (in the 
Options Bar) is set to Current & Below. 
Then, we’ll click on the flip horizontal icon 
within the Clone Source panel. This will 
cause the tool to paste a mirror image of 
the area that was copied and will there-
fore not look exactly the same. We’ll Op-
tion+click (Alt+click on Win) in an area of 
the darker sand beneath the hut on the 
right and then hover the round cursor 
beneath the hut on the left, lining up the 
darker line in the sand before clicking and 
dragging with the brush. Then, I like to ac-
tivate the Spot Healing Brush to break up 
some of the details in the retouch area so 
that it doesn’t look like an exact copy of 
the area on the other side of the photo.

Aligned setting  When using the Clone Stamp Tool or the Healing Brush, there is a 
check box in the Options Bar that you should be aware of. This is the Aligned set-

The Clone Source panel is shown above. 
We want to take the sampled content and 
flip it horizontally when pasting it to the 
retouch area, so we are turning on the flip 
horizontal setting. 
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ting and it determines whether or not the tool remembers where you first clicked 
to apply some retouching. When this check box is turned on, we can use the tool 
to sample from one area and then click over the retouch area to establish the 
alignment. Then, as we continue to paint to apply the retouching, the tool will 
remember that initial click. We can release the mouse button and start painting 
again as many times as we’d like and the tool will still maintain the same align-
ment. If the Aligned check box is turned off, the tool will not remember where you 
initially clicked so you will need to establish the alignment over and over again. For 
this reason, I generally keep the Aligned check box turned on. 

Clone Source reset  We mentioned earlier 
that you can use the settings in the Clone 
Source panel to take the sample content 
and paste it at a rotation, at a different 
size or completely flipped. Because these 
settings change the way the tool works, 
it’s always a good idea to reset all of the 
Clone Source settings when you’re done 
using the tool. This way, it won’t create 
problems for you the next time you go to 
use the tool. Reset all Clone Source set-
tings by clicking the little “u-turn” icon on 
the right side of the Clone Source panel. 

Rome Staircase Image

Color matching The first thing we 
want to do with the image of the 
spiral staircase in Rome is some 
color matching. We would like to 
alter the yellow hue on the ceil-
ing so that it matches the yel-
low hue on the spiral staircase.  

Clicking the circled icon will reset all of the 
Clone Source panel settings.

In this image, 
we want to 
make the 
yellow hue 
on the ceil-
ing match 
the yellow 
hue on the 
stairs.
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We’ll do this with a Hue/Saturation adjustment layer so we’ll click on the Adjust-
ment Layer icon at the bottom of the Layers panel and choose Hue/Saturation 
from the pop-up menu. The Hue/Saturation Properties panel will appear. 

We want the adjustment to affect only the yel-
low hue on the ceiling and not the rest of the 
colors in the image. We’ll turn on the targeted 
adjustment tool, which looks like a little hand 
icon in the upper left corner of the Properties 
panel. We’ll use this tool to click on the yellow 
hue in the ceiling. When we do this, the color 
menu in the Properties panel will automatically 
be set to Yellows and the specific color range 
we clicked on will be targeted by a series of 
bars in the gradient at the bottom of the panel. 
This represents the color range that will be af-
fected by the Hue/Saturation adjustment layer. 
Looking more closely at this gradient, we can 
see that the yellows are fully targeted and there 
are some greens and oranges that are partially 
targeted as well. 

Now, we’re going to drag the Saturation slider up, only paying attention to the 
yellow on the ceiling and ignoring the rest of the photograph. The goal is to make 
it just as colorful as the yellow hue on the staircase, but we’ll be able to go back 
and adjust it more later if necessary. Comparing the two areas we’re trying to 
match, the color on the ceiling is more yellow-green while the color on the stair-
way is more yellow-orange. We will try to shift the color of the ceiling to be more 
orange and we’ll use the Hue slider to do that. We need to determine how far, 
and in what direction, the Hue slider should move, so we’ll look to see where the 
yellow color of the ceiling is located on the gradient. Then, we’ll look to see where 

We used the targeted adjustment 
tool (circled) to click within the 
image on the color we wanted to 
change. This automatically changed 
the color menu to Yellows and tar-
geted the yellows in the gradient.
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the yellow/orange hue is located on the gradient. This is the color we want to end 
up with. In this example, the orange/yellow color we want is located just a little bit 
left of the yellow color of the ceiling. This means that the hue shift we need will 
require us to move the Hue slider a little to the left, so that’s what we’ll do. 

The entire image has shifted in color and we only wanted the change to occur in 
the yellow part of the ceiling, so we will paint on the layer mask attached to the 
Hue/Saturation adjustment layer in order to hide the color change in all areas ex-
cept for that ceiling area. When we add black to a layer mask, we are preventing 
the layer from being visible in the areas that are black. When it comes to adjust-
ment layers, the black “paint” will hide the adjustment, so we will activate the 
Brush Tool and choose a large, soft-edged brush. We’ll make sure that the fore-
ground color is set to black and we will paint over the staircase part of the image, 
hiding the effect. We can now continue to tweak the Hue and Saturation sliders. 

In trying to match the yellow on the ceiling to the yellow on the stairs, we worked in the 
Properties panel for the Hue/Saturation adjustment layer, moving the Saturation slider to 
the right. We also moved the Hue slider to the left, shifting the color from a yellow/green to 
more of a yellow/orange. 
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The changes have taken us in the direction we wanted, but the effect is a little 
too extreme in the area beneath the bottom right quarter of the window. We’ll 

need to lessen the effect a bit here. If we sim-
ply paint with black over the area, it will remove 
the effect completely. That’s not what we want. 
Instead, we’ll lower the opacity of the brush to 
50% by using the Opacity setting located in the 
Options Bar above the main image window. By 
using the brush at half strength, we can lessen 
the effect without removing it completely. We’ll 
use the brush to paint over the area of the ceil-
ing that was too saturated. 

The Hue/Saturation adjustment layer affected all of the yellows in the image, and we only 
wanted the change to occur in the ceiling. Here, we’re painting with black on the layer mask 
attached to the adjustment layer in order to hide the effect in all areas except for the ceiling. 

This is the thumbnail for the layer 
mask attached to the Hue/Satura-
tion adjustment layer. You can see 
that we applied the black brush at 
half opacity in some areas because 
they appear gray in the layer mask. 
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Removing distracting elements in window  The next thing we’re going to work 
on with this image is the distracting brownish rectangles in the window. We could 
either tone them down or remove them completely. Toning them down would be 
faster, so let’s first look at how we could do that. 

We can use another Hue/Saturation adjustment layer to tone down the look of 
the brown rectangles, so we’ll click on the Adjustment Layer icon at the bottom 
of the Layers panel and choose Hue/Saturation. We can use the settings in the 
Properties panel to isolate the brown areas because they are a different color 
from the rest of the skylight. We’ll again make sure that the targeted adjustment 
tool (the little hand icon) is active within the Properties panel. Then, we’ll use it to 
click on one of the brownish rectangles. This will automatically change the color 
menu (within the Properties panel) to Reds and it will isolate the red color range 
that we clicked on within the bars on the color gradient. This means that the Hue/
Saturation settings are only going to affect this targeted color range, which in-
cludes mainly reds, but also some orange and magenta. 

We want the Hue/Satu-
ration adjustment layer 
to target the brown/
reddish rectangles in the 
skylight so we used the 
targeted adjustment tool 
to click on one and you 
can see the color range 
targeted in the Proper-
ties panel (below). 
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Now we’re going to use the Hue/Saturation sliders to try and shift the color of the 
brownish rectangles so they more closely match the blueish color of the rest of 
the window. When we move the sliders, this will change the targeted color across 
the entire image, and that’s ok. We’ll use the layer mask to isolate the rectangles 
later. 

In the Properties panel, we’ll need to move the Hue slider to try and shift the color 
of the rectangles from a brownish color to a blueish color. Because these colors 
are so different from each other, we’ll need to move this slider a lot. In the vid-
eo example, I just played around with it, moving the slider back and forth until I 
got as close as possible to the desired hue. I also needed to move the Saturation 
slider far to the left and the Lightness slider far to the right in order to make the 
rectangles match the surroundings as closely as possible. 

With the red hues targeted with the Hue/Saturation adjustment layer, we moved the Hue, 
Saturation and Lightness sliders so the brown areas in the window more closely matched 
the rest of the window. 
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Now we can see that this color shift affected the yellow/orange hue on the spiral 
staircase, and we didn’t want that. To remove the effect in that area, we’ll activate 
the Brush Tool and use a relatively hard-edged brush (with the foreground color 
set to black) to paint over the staircase, removing the effect from the stairs. 

If we were not able to shift the color of the brown rectangles to the desired col-
or using a Hue/Saturation adjustment layer, there is a different technique to try. 
We’ll create a new, empty layer at the top of the Layers panel. Then, we want to 
set the foreground color to match the desirable blue color of the window. With 
the Brush Tool active, we’ll hold down the Option key (Alt on Win) to temporarily 
access the Eyedropper. We’ll use the Eyedropper to click on one of the windows 
that has the desired, desaturated blue color. This will set that as the foreground 
color. We can then release the Option key to go back to the Brush Tool. We’ll use 

Here, we’re painting with black on the layer mask for the Hue/Saturation adjustment layer in 
order to remove the blue/green color shift from the spiral stairs. 
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the Brush Tool to paint the sampled color over the rectangles we want to change. 
This will completely obscure the areas with paint, but that’s ok. We’ll then change 
the blending mode of this layer to Color or Hue (we used Color in the video ex-
ample) so the effect looks good. 

Now let’s say that we want to remove the brown areas completely. If that’s the 
case, we’ll need to use some retouching techniques. In the video example, we 
hid the two layers that were designed to tone down the brown areas (from the 
technique above), because these won’t be used in the process of removing them 
completely. Normally, I’d first turn to the Clone Stamp Tool for a job like this. How-
ever, the angles and shapes of the individual widow panels vary greatly, and that’s 
going to create a problem for the Clone Stamp Tool. Instead, we’re going to make 
selections around specific areas of window, copy those selections to their own 
layer and then use them to cover up the brown areas. 

Left: On an empty layer, we painted over the brown spots using a color sampled from the 
blue area of the window. Right: The blending mode of this layer was set to Color. 



Challenge Images: Beach Huts & Rome Stairway © Ben Willmore, All rights reserved 18

We’ll zoom in on the first area we want to retouch. Within one of the geometric 
window shapes, the brown area is above an arch shape. We’ll make a selection 
around the panels below the arch shape, since they perfectly reflect the panels 
on the top. The Polygonal Lasso Tool can be used to make this type of selection. 
If we’re working directly on the image layer, we can jump the selection to its own 
layer by using the Keyboard shortcut Command+J (Ctrl+J on Win). If, instead, 
there is more than one layer or adjustment layers, we’ll need to copy the contents 
of all those layers onto its own layer and we can do that by going to the Edit 
menu and choosing Copy Merged.

We’ll use the Move Tool to position this 
copied window segment over the seg-
ment with the brown spot. It will obvious-
ly need to be flipped in order to cover the 
spot correctly. We’ll go to the Edit menu 
and choose Transform > Flip Horizontal. 
We’ll need to rotate the piece into place 
but we will first line the corner of the win-
dow up with the corner of the window in 
the image layer. Then, we’ll activate the 
Free Transform feature by using the key-
board shortcut Command+T (Ctrl+T on 
Win). The Free Transform handles will 
appear around the layer. Because one of 
the corners is already line up, we’ll drag 
the crosshair from the center of the Free 
Transform box and position it over the 
lined-up corners. This little crosshair de-
termines the pivot point. We’ll now click 
and drag outside of the Free Transform 
box in order to rotate the content so that 
it best matches the window underneath. 

The area under the arched window was 
selected and copied to its own layer. We’ll 
need to flip this layer so it matched the 
window on the underlying image layer.

Here, we lined up the corners and activated  
the Free Transform feature. We positioned 
the pivot point over the corners (circled). 
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If it’s hard to tell whether the content is lining up correctly, we can change the 
blending mode of the layer to Darken or Multiply. This will allow us to see the lines 
of the underlying window so it’s easier to tell when things are lining up. 

Sometimes, you won’t be able to 
align content simply by scaling 
and rotating. If that’s the case, 
you can use the Distort com-
mand, which is part of the Free 
Transform feature. This will allow 
us to adjust the four corners of 
the layer independently of each 
other. We’ll go to the Edit menu 
and choose Transform > Dis-
tort. Alternatively, we could hold 
down the Command key (Ctrl on 
Win) while using the Free Trans-
form feature. This will temporari-
ly activate the Distort command 
for the entire time that the key 
is hold down. We can now drag 
the four transform corners inde-
pendently of one another so that 
we can precisely line up the layer 
with the underlying layer. 

When we’re finished, we’ll hit the Enter/Return key to lock in the transformation 
and then set the blending mode back to normal. If there is any extra, unwanted 
content around the edges of the layer, we can use the Eraser Tool (or we could 
paint on a layer mask) in order to remove it.

The Distort command allows us to move each Free 
Transform corner independently of one another, and 
that’s what we’re using here to line things up.


